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NOTIFICATION OF
PROVINCIAL SOFTWARE LICENSING AGREEMENT
with
Ingenuity Works Inc.

The Ministry of Education and Training of Ontario and Ingenuity Works Inc. have
negotiated a provincial software licensing arrangement for all Public Schools of Ontario for
the software All The Right Type in the following format:

- Macintosh 3.5" floppy disk or CD-ROM

256 colours at 640%480 resolution, System 7.0 or greater, 2.5 MB free RAM
68030 at 25 Mhz or better, 68040 or PowerPC processor

This arrangement provides your School with certain rights and responsibilities. In using
this software, your School agrees as follows:

-To only make as many copies of the master disk(s) and this manual as are required for
teaching purposes within the School. Copies of the program, the master disk(s) or copies
of this manual may not be given to students to take home.

-That you have the right to offer special disks for students to take home, available through
Ingenuity Works. Schools will receive information kits every September and January, or
you can print and distribute the forms in the appendix of this manual.

-The program may be installed on any Macintosh compatible network within the school.

-That the copies of the software (physical or electronic) made under this agreement are
intended to be used within the school for teaching purposes.

-That you have the right to display the video images of All The Right Type for educational
purposes, using a Liquid Crystal projector, rear screen projector, large screen monitor, or
functionally comparable device.

-To inform students, faculty and staff of the terms and conditions of this Agreement.

-Allow Ingenuity Works to spot audit the premises to ensure compliance with the terms and
conditions of this Agreement.

If you have any questions regarding your rights and the Licensing Agreement, please
contact Steve Solway at the Ministry of Education and Training of Ontario, Canada.
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Chapter

Getting Started

This chapter covers the following topics:

Check Your System Requirements ..........ccccceeveevenenee. 2
Make a backup COPY ....ccvevevveerieieieieie e 2
Installation (stand alone computer) .........ccoceoeeerrienenee. 2
General Network Considerations .........ccccccevvvvvceenee. 3
AppleShare networking (version 3 or 4) ..........c........... 5
System 7 or 8 built-in networking (File Sharing) ......... 8
Novell Netware Server with Macintosh support ......... 10
USING AT EGSE ...o.oovveeeeceeeee e 13

Launching All The Right Type or the Utility Center..... 13




1. Getting Started

1.

GETTING STARTED

Check Your System Requirements

e A Macintosh compatible system with a 68030 processor at 25 Mhz or better,
or a 68040 processor, or a PowerPC processor.

e 2.5 MB (2500K) free, available RAM

® 6 MB available hard drive space

® 256 color display at a minimum of 640*480 resolution

e System 7.0 or higher

e If you have the program on floppy disks your system must have a high density
(1.4Mb) 3.5" floppy disk drive.
* If you have the program on CDROM, your system must have a CDROM drive.

Make a Backup Copy

Before you install All The Right Type, make a backup copy of each of the installer
disks in your package. Store the backup set in a safe place.

We recommend that you write-protect the backup set to prevent accidental erasing
or overwriting of files.

Installation (stand-alone computer)

Turn off any screen savers and virus protection software that may be installed on
your system. Insert the All The Right Type CDROM or installer disk #1, and
double-click on it once it appears on your desktop. The All The Right Type
Installer icon appears.

Double-click on the All The Right Type Installer icon.

Carefully read the instructions. The All The Right Type Installer creates a folder
containing All The Right Type on your hard drive. After installation is finished,
you may drag and drop it to any place you would like.

If you installed the Utility Center, you should launch it right away and set up a
password, see page 17.

Page 2
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1. Getting Started

General Network Considerations

Different kinds of applications

Applications like word processors and spreadsheets are mainly made up of code -
they have very little graphics, animations or sound. When a user logs onto the
network and runs this kind of application, most of the program is loaded
immediately into the memory of the local computer. After the initial load, network
activity is minimal. These programs run well on networks - even slow networks.

Applications like the color version of All The Right Type are dependent on large
files of pictures and sounds and do not contain much code. When a user logs onto
the network and runs this kind of application, the code of the program is loaded
quickly into the memory of the local computer. As the students go through the
buildings on the ART campus, various pictures or sounds are needed and must be
loaded over the network. This means that network activity is high. Highly
graphical applications such as the color version of All The Right Type run well on
fast networks - but may not run fast enough to be practical on slow networks.

Network speed

There are many different kinds of networks. The speeds can range from very slow
to very fast. Here are some of the things that can affect network speed:

Network wiring and protocols:

LocalTalk cabling (standard telephone wires, Phone-Net, inexpensive two-
conductor wire of any kind) is only good enough to run AppleTalk, the built-in
protocol for all Macintosh computers. While networks based on this cabling are
inexpensive, they are slow.

High speed protocols such as Ethernet or Token Ring are much faster, but they
don't run on LocalTalk cabling. Ethernet cables typically move data 40 times as
fast as LocalTalk.

Network traffic: 1 user (faster) to 50 users (slower)

If there is only one user logged on to the network, the number of requests for
information that the server has to process is small. As more users are logged on,
the number of requests for information increases and if the file server can't keep
up, users begin to notice delays.

LLTHE RIGH
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1. Getting Started

File server: Macintosh Classic (slower) to Mac Workgroup Server (faster)

The ability of the server to handle large numbers of requests for information is
affected by many factors. Processor type and speed, speed of hard drive,
networking software and the amount of RAM allocated to 'caching' will all affect
the overall speed of the network.

Type of other programs being concurrently accessed: text, graphics & sound

If other stations on the network are accessing programs that use graphics,
animation and sound, the load on the server is increased and all stations may
experience slowdowns. If this is a problem, limit the number of users of that other
software, or increase the power of your server and network.

Deciding how to install All The Right Type

There are two main configurations for All The Right Type, as follows:

Network resident: The entire program and the recordfiles reside on the file server.
To use this configuration you must have a fast network.

Local: This configuration should be used if you have a slow network. The
recordfiles reside on the file server and the applications reside on the local hard
drive of each computer.

In general, networks that use LocalTalk are 'slow' and networks that use Ethernet
or Token Ring are 'fast'. If you are unsure of the speed of your network, wait until
there is no network activity and use the following test to measure performance.

e At a computer with a local hard drive, run the All The Right Type Installer (on
disk #1 of 2) and install the Student Workstation package onto the local hard
drive.

e At the same local computer, log onto the network as Administrator. The file
server volume (icon) will appear on your desktop.

e Have a stopwatch (or anything capable of timing seconds) ready. Drag and
drop the All The Right Type application onto the file server icon and time how
long it takes to copy. Then remove the All The Right Type application from
the file server.

If the copy operation took more than 30 seconds, you have a 'slow' network.

ALLTHE RIGHT
E
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1. Getting Started

Installing All The Right Type on a slow network

If you can't upgrade to a fast network you have two choices:

Install the Student Workstation package onto the local hard drive of each
computer, while placing the recordfiles on the server. The recordfiles are
relatively small and load quickly over the network. We have designed the
color version of All The Right Type so that this is possible.

If you absolutely cannot install the Student Workstation package onto the
local hard drive of each computer, you could run the Black & White version,
which is much smaller and loads faster over slow networks. Call your district
computer or technology co-ordinator to get the additional format.

AppleShare networking (version 3 or 4)

1.

Read the section called General network considerations on page 3 and decide
which configuration you should install, Network resident or Local.

Now you have to choose which program modules to install.

-If you have a slow network and have you have decided to install the Local
configuration, you don't have to install anything on the server at this time.
You must go to each workstation and install the 'Student Workstation'
package. At the teacher's computer, install the 'Complete Install' package.
The teacher creates the recordfiles and places them on the server in a location
that has 'Make Changes' access for the students. Students sign on to the
network, locate and launch the recordfile for their class.

-If you decided to install the Network resident configuration, at the file server,
quit AppleShare File Server. Insert the All The Right Type installer disk #1 and
launch the installer. Read all instructions carefully. Select and install the
Complete Install package.

When the install process has finished there will be a folder called All The Right
Type f on the server. You should now drag and drop it to wherever you want
it to be permanently located.

Open the new All The Right Type f folder and arrange the files so it looks like
the following:

ALLTHE H]GHT
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1. Getting Started

o All The Right Type { EE
ih
u
EE
11 The Right Tupe Utility Center
4
SimpleText AHTRT Pouch
]
&=l [c]E

Create a new folder called ATRT Applications. Drag and drop the ATRT
Pouch folder and the All The Right Type and Utility Center applications into
the new ATRT Applications folder.

[I=——— fll The Right Type {

=2

ATRT &pplications

SimpleText

=]

< B2

5. Launch the AppleShare Admin program and choose Access information from
the Privileges menu.

In the list in the upper left corner of the window, locate the All The Right Type
f folder, click once to highlight (select) it and set rights as follows:

|:| Same az Encloging Folder Ses S.ee Make E Change 4T1
Folders Files Changes
i Enclozed

B E B e
Userfﬁroup: | | 4 [4] Can't Mowve,

Rename,

Everyone: E E E Delete

When setting rights, always set the 'Same as Enclosing Folder' option in the
upper left before trying to set the other options. When the screen looks exactly
like the above illustration, choose Save. Choose Inherit if prompted.

6. In the same list, double-click on the All The Right Type f folder, and a new list
will appear. Click once on ATRT Applications to highlight (select) it and set
rights as follows:

ALLTHE RIGHT
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Note:

|:| Same as Enclosing Folder FS];E ;:Sf;e l:::Iake- E Change 411
alders Files anges | Enclosed

R OR| e
User.r'Group: | | = [ Can't Move,

Renarme,

Everyone: | B O Delete

When the screen looks exactly like the illustration, choose Save. Choose Inherit
if prompted.

In the same list, double-click once on ATRT Applications folder, and a new list
will appear. Click once on All The Right Type to highlight (select) it and set
rights as follows:

[<] Copy Protected I:I Concurrent User Limit

|:| Locked

When the screen looks exactly like the illustration, choose Save.

Choose Quit from the File menu. Sign on to the server as a Teacher. Locate
and run the Utility Center application and set up a password. If you do not set
up a password now, students will be able to run the Utility Center - which is
not advised.

That's it! Students can now run as 'Guests'. If teachers want records to be

kept, they should use the Utility Center to set up a Recordfile for each class.
Recordfiles can be located anywhere on the server that students have 'Make
Changes' access. Or they could be located on floppy disks or even on their

local hard drives.

Drillfiles (created with the 'Utility Center' program) must always be located in the

ATRT Applications folder.

Note:

You should back-up the Recordfiles regularly to avoid loss of records due to

mishap.

ALLTHE RIGHT'
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System 7 or 8 built-in networking (File Sharing)

Note:  System 7 or 8 Networking supports a maximum of 10 simultaneous users per
Recordfile. If you put more than 10 students in the same Recordfile, only the first 10 to log
on will be able to run the program!

Use the following procedure to install ALL THE RIGHT TYPE:

Read the section called General network considerations on page 3 and decide
which configuration you should install, Network resident or Local.

Now you have to choose which program modules to install.

-If you have a slow network and have you have decided to install the Local
configuration, you don't have to install anything on the server at this time.
You must go to each workstation and install the 'Student Workstation'
package. At the teacher's computer, install the 'Complete Install' package.
The teacher creates the recordfiles and places them on the server in a location
that has 'Make Changes' access for the students. Students sign on to the
network, locate and launch the recordfile for their class.

-If you decided to install the Network resident configuration, at the 'server',
insert the All The Right Type installer disk #1 and launch the installer. Read
all instructions carefully. Select and install the Complete Install package.

When the install process has finished there will be a folder called All The Right
Type f on the server. You should now drag and drop it to wherever you want
it to be permanently located.

Open the new All The Right Type f folder and arrange the files so it looks like
the following:

S All The Right Type § ZE
&
B
=@
411 The Right Type utih‘Tg Center
=
SimpleText AHTRT Pouch
=
] EE
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1. Getting Started

Create a new folder called ATRT Applications. Drag and drop the ATRT
Pouch folder and the All The Right Type and Utility Center applications into
the new ATRT Applications folder.

[I=———— All The Right Type f =———01
[

ATRET Applications

SimpleText

EIE

2] E

5. Use the Sharing... option under the File pull-down menu and set the access
privileges for the folders as follows:

A 1) The Right Type |
.- T .- b, W | s
[E] mhara i e g # pomviewa [E] sara i ey i peviewa
Enp e Pk e Nwe Pl
Fubbivd Fried S Folder s Tilet Chiged
(- B B & Oowvar B B B
Wrer e eey [ Trafer | BB & User /s B B B
1 v B B B B gmr B E O
|:| Highy ¢l curremily sucloss] Fodery Hiby Ty ooy |:| Highy &l corranily suclomsd fndery Hip Ty oo
[E] £t b rmoevndd, s o siintnd B Cart b v, rerermd e dieted

6. Run the Utility Center application and set up a password. If you do not set up
a password now, students will be able to run the Utility Center - which is not
advised.

7. That's it! Students can now run as 'Guests'. If teachers want records to be
kept, they should use the Utility Center to set up a Recordfile for each class.
Recordfiles can be located anywhere on the server that students have 'Make
Changes' access. Or they could be located on floppy disks or even on their
local hard drives.

Note:  Drillfiles (created with the 'Utility Center' program) must always be located in the
ATRT Applications folder.

Note:  You should back-up the Recordfiles regularly to avoid loss of records due to

mishap.
ALLTHE H]GHT
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1. Getting Started

Novell Netware Server with Macintosh support

1. Read the section called General network considerations on page 3 and decide
which configuration you should install, Network resident or Local.

2. Now you have to choose which program modules to install.

-If you have a slow network and have you have decided to install the Local
configuration, you don't have to install anything on the server at this time.
You must go to each workstation and install the 'Student Workstation'
package. At the teacher's computer, install the 'Complete Install' package.
The teacher creates the recordfiles and places them on the server in a location
that has 'Make Changes' access for the students. Students sign on to the
network, locate and launch the recordfile for their class.

-If you decided to install the Network resident configuration, from a
Macintosh workstation, sign on as Supervisor, or equivalent. The network
volume icon should appear on your Macintosh desktop. Insert the All The
Right Type installer disk #1 and launch the installer. Read all instructions
carefully. Select and install the Complete Install package.

3. When the install process has finished there will be a folder called All The Right
Type f on the server. You should now drag and drop it to wherever you want
it to be permanently located.

4. Open the new All The Right Type f folder and arrange the files so it looks like
the following:

= All The Right Type f BI=
ih
u
EE 1
11 The Right Tupe Utility Center
=
SimpleTewxt AHTRT Pouch
=
] EE

Create a new folder called ATRT Applications. Drag and drop the ATRT
Pouch folder and the All The Right Type and Utility Center applications into
the new ATRT Applications folder.

ALLTHE RIGHT
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1. Getting Started

T
ol

fill The Right Type f ==——"=u=p1=

ATRET Applications

SimpleText

=[]

] o

If you have not set up a "user list" and/or "group list" for the intended class,
do so now (see your Novell Netware manual).

Use the "NETWARE CONTROL CENTER" application (part of Novell) to
set access privileges using the following procedure:

-Open the server volume and select the All The Right Type f folder.
-Choose "folder trustee rights" under the FOLDERS/FILE pull-down menu.

-Drag the appropriate group list (or user list) into the Trustee list. The current
access rights will appear. Set rights as follows:

Students Teachers
] Parental [ Parental
B write to open files ] write to open files
B Create files/folders [ Create files/folders
[1 Delete files/folders [ Delete files/folders
B Modify file attributes [ Modify file attributes
<] Open existing files [ Open existing files
(<] Read from open files [< Read from open files
B Search: [ search:

-Open the server volume and select the ATRT Applications folder.
-Choose "folder trustee rights" under the FOLDERS/FILE pull-down menu.

-Drag the appropriate group list (or user list) into the Trustee list. The current
access rights will appear. Set rights as follows:

ALLTHE RIGHT'
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1. Getting Started

Students Teachers
[] Parental & Parental
[ write to open files [ write to open files
O Create files/folders B Create files/folders
[] Delete files/folders [ Delete files/folders
O] Modify file attributes B Modify file attributes
] Open existing files (< Open existing files
[] Read from open files (< Read from open files
] search: B Search:

7. Sign on to the server as a Teacher. Locate and run the Utility Center
application and set up a password. If you do not set up a password now,
students will be able to run the Utility Center - which is not advised.

8. That's it! Students can now run as 'Guests'. If teachers want records to be
kept, they should use the Utility Center to set up a Recordfile for each class.
Recordfiles can be located anywhere on the server that students have 'Write'
access. Or they could be stored on floppy disks or on their local hard drives.

Note:  Drillfiles (created with the 'Utility Center' program) must always be located in the
ATRT Applications folder.

Note:  You should back-up the Recordfiles regularly to avoid loss of records due to
mishap.

Page 12
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1. Getting Started

Using At Ease

At Ease is a utility program that displays chosen applications and documents as
buttons, and denies access to other places normally accessible in the Finder. This
can help protect the server from being re-arranged or protect files from being
'trashed’'.

All The Right Type has been tested and works perfectly through At Ease. The
recommended way of setting up All The Right Type on At Ease is to put each of
the class Recordfiles as a button on the At Ease document screen, not the All The
Right Type application itself. This way, when a student logs on and the At Ease
button panel appears, the student simply finds the Recordfile for the appropriate
class and clicks on it. All The Right Type will automatically launch.

For instructions on how to add buttons to At Ease, or if At Ease gives error
messages when you launch a Recordfile, consult the At Ease manual for a solution.

In order for the "Word Processing Plaza' to function under 'At Ease', the Word
Processor must be located on the local hard drive, or in the same directory as the
All The Right Type application. And it must be an item on the student's panel.

Launching All The Right Type or the Utility Center

To launch All The Right Type from the desktop, students should double-click the
Recordfile that contains their name. If no Recordfile has been created, or someone
wants to be a "Guest," it can be launched by double-clicking the All The Right
Type application icon itself. Records for a "Guest" will not be saved to disk.

To launch the Utility Center, teachers double-click the Utility Center icon.

If you are using At Ease, put the class Recordfiles as buttons on the At Ease
document screen, not the All The Right Type program. This way, a student simply
finds the Recordfile for the appropriate class and clicks on it. All The Right Type
will automatically launch. For instructions on how to add buttons to At Ease, or if
At Ease gives error messages, consult the At Ease manual for a solution.

Also, some versions of At Ease can be configured to open documents only from
floppy disks. To avoid being prompted for a floppy disk when you launch All The
Right Type, this At Ease Security option must be set to allow opening files in the
user’s folder.

In order for the "Word Processing Plaza' to run under At Ease, the Word Processor
must be located on the local hard drive, or in the same directory as the All The
Right Type application. And the Word Processor must placed as a button on the
At Ease document screen.

LLTHE RIGH
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Chapter

QUICK TOUR

This chapter covers the following topics:

Overview of the A.R.T. Campus .................. 15
Overview of the Utility Center .................... 16
Guided TOUr ....eneeeeii e 17

Creating a New Recordfile ............................
Signing On to All The Right Type .....................
The Learning Lab for New Key Lessons .............
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2. Quick Tour

2. QUICK TOUR

All The Right Type is an interactive program designed to teach keyboarding. It
consists of two separate programs — All The Right Type for students and the
Utility Center for Teachers. The program comes with a Drillfile (set of Lessons,
Skill Builders and Tests) called All The Right Type. It is the default Drillfile.

Overview of the A.R.T. Campus

Learning Lab Practice Pavilion Skill Building

Teaches proper posture and Same drill material as Learning Lab, but with ~ Students hone their skills with a series
hand position. Then each new  a speed goal. The practice method can be of graduated drills containing words,
key is taught with its correct ~ configured by the teacher to standard lines ~ sentences, and a short meaningful
finger reach without worrying  and reports - or an animated race against a paragraph.

about speed. pacer scull on a river.

1 i

i 7
Word Processing Plaza Records Library Testing Center
Clicking here links you to your Students may view and print the Students take tests after every third Lesson.
favorite word processing results of their work with the Tests are marked in accordance with rules
program. Skill Builders and Tests at any used by leading typing authorities. Testing

time. method, goals and time limits can be set by

teachers.
ALLTHE RIGHT
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2. Quick Tour

You can enter any building at any time by clicking on it. If you are using the built-
in All The Right Type Drillfile, the flashing building is the next in the proper
learning sequence (see chapter 3).

e
Overview of the Utility Center

All The Right Type’s Management System for Teachers

The second component of All The Right Type is the Utility Center. It permits
teachers to set up records, make their own Lessons, Skill Builders, and Tests, and
specify program options to suit individual teaching preferences.

File Edit

-h
Understanding Recordfiles g\ﬁ’;ﬂ@‘ﬂ/

A 'Recordfile' is a collection of up to 50 student records and individual program
options. There is no limit (other than hard drive space) to the number of
Recordfiles you can create. The Utility Center allows you to:

a) Manage student records

- Create and name student records
- Import lists of names

- Customize and set student options

b) Evaluate student results

- Monitor individual/class progress for Skill Builders and Tests
- Print results either graphically or in text format
- Award certificates

- Monitor progress through the Learning Lab and the Practice Pavilion

ALLTHE RIGHT
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2. Quick Tour

% File Edit

Understanding Drillfiles I@']E'E’

A 'Drillfile' is a collection of Lessons, Skill Builders, and Tests for use with the
main program All The Right Type. There is no limit (other than hard drive space)
to the number of Drillfiles you can create. The Utility Center allows you to:

a) Create your own Lessons, Skill Builders, and Tests.

b) Edit your own material.

¢) Cut and Paste drills from another source (such as a word processor).
d) Print your Lessons, Skill Builders, and Tests.

A Guided Tour

Creating a New Recordfile

To learn about all the features of All The Right Type, the first thing you should do
is try out the 'records' feature of the program!

fh‘n

£=

Run the Utility Center program *H§ =i,

L=

Note: The very first time the Utility Center is ever launched, it lets you set up a password. This is
intended to prevent students from running the Utility Center and potentially deleting records or
drills. If you forget the password or if you want to change it, see the troubleshooting section in
the appendices.

The Utility Center tool bar will appear.

= File Edit

SR

Click the 'New Recordfile' icon at the left side of the toolbar. An empty new
recordfile will appear, with the name 'Untitled Recordfile' in the titlebar.

LLTHE B:]GHT
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2. Quick Tour

The toolbar buttons for the various Recordfile features will become active (color).

fulfal EldaliEE

iv) Click on the +student icon. The 'Add Student' dialog will appear.

Add Student

Student Name:|£|izahetn |

[Drinfile... | {All The Right Type . [JClear Results
Lesson Error Threshold: Penalty: [I <] Word Wrap
Lesson Error Effect: @ Beep {3 Caption Flash g EFIE:E KL‘?H

isplay Lines
Practice Mode: i » Standard & Pacer Practice m USED'UJLII-'IM'
Test Mode: i@ Speed Goal | 20 WPM vl Space After Period:
(3 Timed Writing | 3 minutes  +| | @o0ne (3 Two

[ Help ] [ Cancel ]

v) Enter the name of a student. Set options exactly as illustrated above, then
click 'Add'. To learn about the various options, click on the 'Help' button, or
see chapter 5.

vi) Click the +student icon again to add another student. Notice that the
program remembered the options you had set for the previous student, and
brought them up automatically for the new student. Note that if you already
have the names of the students in a file on your computer, you don't have to
retype them! There is an 'Import Names' feature that does it all in one step,
see chapter 5.

vii) When you have finished entering the names of students, quit the Utility Center.
The program will prompt you to save the changes, then name the recordfile.
Give it a name that identifies a class such as Mr. Smith, Period 1A and save it.
Everything is ready for the students to use All The Right Type.

ALLTHE RIGHT

Page 18 __®L.



2. Quick Tour

Understanding the learning sequence

Make sure that students understand the proper learning sequence as outlined in
Chapter 3.

If you use the built-in All The Right Type Drillfile, the flashing building is the next
in the proper learning sequence. When students enter a building, the next drill in
the sequence will be highlighted automatically.

Signing On To All The Right Type

i)

ii)

iii)

To launch All The Right Type from the desktop, students should double-click
the Recordfile that contains their name, in this case Mr. Smith, Period 1A.
Students could launch by double-clicking the All The Right Type application
icon itself, but then they would have to locate and open the Recordfile. It is
faster for the student to double-click directly on the Recordfile.

Mr. Smith’s Period 14

If All The Right Type is already running (and is currently signed on as 'Guest',
'Evaluator', or as some other student), students should choose 'Sign On..."
from the File menu. Then they can then locate and open the Recordfile for
their class.

After the program identification window, the 'Student Selection' dialog will
appear with a list of all the students in the Recordfile.

Choose a student name, then click 'Select'. A welcome message appears, and
the options for that student are loaded. The 'Faculty of A.R.T." appears.

ALLTHE H]GHT
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2. Quick

Tour

The flashing building always indicates the next step in the proper learning
sequence. In this case it is the Learning Lab.

The Learning Lab for New Key Lessons

In the Learning Lab, students learn proper posture and hand positioning. Then
each new key is taught with its correct finger reach, without worrying about speed.

i) Click on the Learning Lab. The first time you enter the Learning Lab, the
Posture and Hand Position tutorials run automatically. When you enter again,
these tutorials are available as buttons on the Learning Lab dialog.

Learning Lab

[ Posture Review | [ Hand Position Review |

rLearn Mew Keys

1 - Home Row

2-Eand U

3 - Capitals and Period

4 - R and |

5~ 6 and H

6-0andl
7 Tandy 3

ALLTHE RIGHT
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2. Quick Tour

ii) The next Lesson in the proper learning sequence is automatically highlighted.
Select the Lesson and click 'Select'. A keyboard appears and the Lesson
begins. As new keys are encountered, the proper reach and fingers are taught
and illustrated.

wE ey Letenn | - Bame Baw
i L - ] i R & =
I ] ] L] B B ¢ B 1 1] o
I
i L} b F R T ¥ [E] I L: P L 1 i
LY a H e
B M
& +

Type these letters.
ETE

iii) The students follow the instructions at the bottom of the screen, working their
way through the Lesson. If an error is made the program will show the correct
reach and fingering, and pause until the correct character is typed.

iv) After the last line of the Lesson, a fireworks display appears. The more
Lessons a student completes, the better the fireworks display! Clicking the
Show Results button (top left corner) will bring up a final report for the
Lesson.

The Practice Pavilion for Developing Speed ‘

The Practice Pavilion uses the same drill material as Learning Lab, but with a speed
goal. The presentation method can be preset by the teacher to be standard lines
and reports - or an animated race against a pacer scull on a river when you first
enter the student's name. For the purposes of this 'Quick Tour' you had set the
practice mode to be 'Pacer’, see page 18.

ALLTHE R

GHT
[E]. Page 21



2. Quick Tour

i)  Click on the Practice Pavilion. The Practice Pavilion dialog appears, as follows:

Practice Pavilion

rSelect a Lesson

1 - Home Row

2-Eand U

3 - Capitals and Period

4 - R and |

9-GandH

6-0andl

?-Tand ¥

g-BandC

9-MandN

10 - P and O ]

[ Cancel ][ Help ]

ii) The next Lesson in the proper learning sequence is automatically highlighted.
Select a Lesson and click 'Select'.

iii) Since you selected 'Pacer' mode on the Student Options dialog (page 10), the
student is prompted for the desired speed for the pacer boat. Then a river will
appear with two racing sculls, as follows:

Faer Fraclice

The bottom racing scull is the pacer. It will move at the selected speed. The
top boat will move at the speed the student types. The race starts as soon as
the first character is typed. The goal is to stay ahead of the pacer boat.

The small 'Overview' window shows the relative position of the two racers
compared to the length of the entire Lesson. This window can be moved. At
the end of the race a trophy appears with another plaque added.

ALLTHE RIGHT
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2. Quick Tour

LETT
The Skill Building for Building Skills -T:#

In the Skill Building, students build speed and accuracy with a series of graduated
drills containing words, sentences, and then a short paragraph.

i)

ii)

iii)

1v)

vi)

Click on the Skill Building. The Skill Building dialog appears, as follows:

5kill Building

r5elect a Skillbuilder

1 - Home Row
2-EandU

3 - Capitals and Period
4 - R and I

S5-GandH
6-0Dandll

?P-Tand¥

8-BandC
9-mMandN

10 - P and 0O

[ Cancel ][ Help ]

The next Skill Builder in the proper learning sequence will be automatically

highlighted. Select the Skill Builder and click 'Select'.

Upon completion of the Isolated Words section, a report appears. Check your
speed and errors; then click 'Next Section'. Results are recorded in the
Recordfile.

The Sentences section appears. Type the sentences. Upon completion of the
last sentence, a report appears. Check your speed and errors; then click 'Next
Section'. Results are recorded in the Recordfile.

The Paragraph section appears. Type the paragraph. Upon completion of the
paragraph, a report appears. Check your speed and errors; then click
'Continue'. Results are recorded in the Recordfile.

The first portion(s) of a humorous cartoon are revealed. Each time a student
completes a Skill Builder another portion of the cartoon is uncovered. When
the final Skill Builder is finished, the last portion is uncovered and the green
'grid' lines disappear!

ALLTHE RIGHT'
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2. Quick Tour

'8 -9

The Testing Center for Testing Progress 4'-'“';""']1'

In the Testing Center, students take tests after every third Lesson. Tests are marked
in accordance with rules used by leading typing authorities. Testing method, goals
and time limits can be configured by the teacher, see chapter 4.

i)  Click on the Testing Center. The Testing Center dialog appears, as follows:

Testing Center

r5elect a Test

1a - Covers Lessons 1-3
1b - Covers Lessons 1-3
1c - Covers Lessons 1-3
Z2a - Covers Lessons 4-6
2b - Covers Lessons 4-6
2c - Covers Lessons 4-6
2d - Covers Lessons 4-6
Z2e - Covers Lessons 4-6
2T - Covers Lessons 4-6
3a - Covers Lessons 7-9

[ Cancel ][ Help ]

ii) The next Test in the proper learning sequence is automatically highlighted.
Notice that after Lesson 3 you have only three Tests to choose, but after
Lesson 6 you have six Tests to choose. Click on the Test and click 'Select'.

Since you selected 'Speed Goal' mode and a goal of 20 WPM on the Student
Options dialog (page 18), the program reminds you of the goal.

When you press the RETURN key, the program will calculate where you
should be in exactly one minute if you are typing at the desired speed, and
mark that character on the screen as a visual goal. You should finish the test,
even if you get past the marker before the beep.

Results are recorded in the Recordfile.

ALLTHE RIGHT
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2. Quick Tour

.

n—

The Word Processing Plaza % =

You can easily access your favorite word processor by clicking on the Word
Processing Plaza building. By default, the built-in Macintosh word processor
"TeachText' or 'SimpleText' is used. Refer to Section 4. All the Right Type -
Advanced Features in this manual for details on how to change this setting to
access a different word processor.

i_-
The Records Library ‘III;':- i-ifllh

Students can examine their own records at any time by clicking on the Records

Library. If they have not signed on through a Recordfile only their work during
the current session will be visible. If they signed on through a Recordfile, all of
their Skill Builder and Test results will be available.

By default, the report appears in 'Text' format, which is on a single page, unless the
student is using a very large custom Drillfile.

il Commands

Previous

Print

Students can change to 'Graphic' format by clicking the 'Graphic' button.

They can move through the different pages of the 'Graphic' report by clicking the
Next button and the Previous button.

They can print their record by clicking the 'Print' button.

You have now worked through the most important features of All The Right Type
and created some records. In the next section you will work with the Recordfile
and see how you can view student progress in various ways. Before going on, you
may want to sign on to All The Right Type as an 'Evaluator Guest' so that you can
see how the program behaves when various student options are changed.

ALLTHE R
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2. Quick Tour

Working with a Recordfile

In the previous section, you created a new Recordfile and entered some names into
it. Then you launched All The Right Type, signed on through your Recordfile and
saved some records.

The records system in All The Right Type permits teachers to manipulate student
records in various ways to track student progress and assign grades.

In addition, you can create and print your own award certificates at any stage of a
student's progress. These certificates are an excellent motivational tool.

Viewing and printing one student's record

Launch the Utility Center and click the 'Open' icon from the toolbar. Locate and
open the Recordfile.

To view one student's record, select that student and click the 'View Student
Records' icon in the toolbar.

o) ) e ()

A report of the student's progress on Skill Builders and Tests appears in Text
format. You can also view the results in graphical form by choosing 'Graphic
View' from the Reports menu, or click the 'Graph Mode' button in the toolbar.

kA

@Mﬁltﬁl)@l@l@l = S 7]

Viewing and printing class records

You can see how the entire class performed on a particular Skill Builder or Test.

To view Test results, click the 'View Tests' icon in the toolbar.

ALLTHE RIGHT
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A list of all the Tests in the Drillfile appears. Select one from the list and click
'OK".

A report showing class performance on that Test appears. You can also view the
report in graphical form by choosing 'Graphic View' from the Reports menu. To
print the report, choose 'Print' from the File menu or click the 'Print’ button

&)

=4
)
&
|
<
4
&
Q
E

Repeat the process for Skill Builders.

Checking Lessons completed in the Learning Lab and Practice Pavilion.

Launch the Utility Center and open the Recordfile for your class. Select a
student's name and choose 'Lesson Progress' from the Reports menu.

The Lessons this student has completed in the Learning Lab and Practice Pavilion
are displayed. This report can be printed. Choose 'Print' from the File menu.

ALLTHE RIGHT'
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3. Understanding the Learning Sequence

Understanding the learning sequence

; Prﬁce&eing Plaza

In All The Right Type, students learn keyboarding in the buildings of the Faculty
of A.R.T.

Learning Lab

Here students learn new keys and concentrate on correct finger reaches without
being concerned with speed.

Practice Pavilion

Here students reinforce the finger reaches they learned in the Learning Lab. The
practice material is the same, but presented in two formats. The first, called
Standard, presents practice lines as straight text. The second, called Pacer,
presents practice lines as a racing scull race on a river. Students must type at a
preselected speed to stay ahead of a pacer scull and reach the finish line first.

Skill Building

Here students increase speed and improve accuracy with three types of drills: (1)
words currently available, (2) sentences, and (3) paragraphs. Input is marked for
speed and accuracy and results are recorded in Recordfiles.

ALLTHE RI
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3. Understanding the Learning Sequence

Students repeat the above sequence for three lessons, and then go to the Testing
Center.

Testing Center

Here students take a test after completion of every third lesson.

It is imperative that your students understand and follow the above learning
sequence. To help students do this, the next building they should enter flashes.

Once inside a building, the next lesson in sequence is highlighted.

Students can enter any building they want and choose any drill. You may
recommend this if reinforcement on particular keys is indicated.

ALLTHE RIGHT
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4. All The Right Type - Advanced Features

4. ALL THE RIGHT TYPE - Advanced Features

Before reading this section of the manual you should take the Quick Tour in
Chapter 2 of this manual.

Signing On as a Guest

Usually, students choose the appropriate Recordfile for their class, open it and then
select their name from the list. All The Right Type loads and sets up the proper
options for the student, and progress records are automatically kept in the system.

But if the user doesn't want records to be kept from one session to another, or if no
Recordfiles have been set up yet, users must click on the 'Guest' button.

There are two types of 'Guest'—Student and Evaluator. If you choose 'Student
Guest' you can choose from available Drillfiles, but the program will always use
the default student options.

The 'Evaluator Guest' feature is intended for Teacher use only. Teachers can
familiarize themselves with all aspects of All The Right Type by actually trying all
the various student options - without having run the separate Utility Center
program which is normally used to assign these options to students.

Records for guests are maintained for the current session only.

The Buildings of the Faculty of A.R.T.

Learning Lab

In the Learning Lab the goal is to practice correct posture, hand position and the

proper fingers and reaches used to type. Time is not an issue. Encourage students
to work carefully and ensure that they always use the correct finger and technique.
Progress in the Learning Lab is based only on accuracy, not on the speed you type.

Instruct your students to periodically look at the Posture Review and the Hand
Position Review to make sure they are sitting and holding their hands correctly.
The first time a student enters the Learning Lab, the program automatically takes
them through the Posture Review and the Hand Position Review.

ALLTHE RIGHT
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4. All The Right Type - Advanced Features

Student Options that affect the Learning Lab are:

-Lesson Error Effect
-Lesson Error Threshold
-Space after period

See the section 'Student Options and Their Implications' in this chapter for details.
Remember that 'Student Options' are set from within the Utility Center. See
chapter 5 'Setting Program Options for your Students'.

Practice Pavilion

The Practice Pavilion uses the same actual drill material used in the Learning Lab.
Student Options that affect the Practice Pavilion are:

-Practice Mode
-Penalty
-Backspace Key
-Space after period

See the section 'Student Options and Their Implications' in this chapter for details.
Remember that 'Student Options' are set from within the Utility Center. See
chapter 5 'Setting Program Options for your Students'.

If the 'Practice Mode' option is set to 'Standard', the student is prompted for a
minimum speed goal to advance to a new line. The practice lines appear one at a
time. After each line the student gets a report on the speed and errors for the line.
After the last line a trophy appears with another plaque added.

Skill Building
In the Skill Building the goal is to build speed and accuracy.

Each Skill Builder consists of three sections — Isolated Words, Sentences and
Paragraphs. Students choose a realistic speed goal then work through the
material. Words per minute and errors are recorded for each of the three sections.

Student Options that affect the Skill Building are:

-Penalty

-Word Wrap
-Backspace Key
-Display lines
-Space after period

ALLTHE H]GHT
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See the section 'Student Options and Their Implications' in this chapter for details.
Remember that 'Student Options' are set from within the Utility Center. See
chapter 5 'Setting Program options for your Students'. Words per minute and
errors are recorded for each section of the Skill Builder.

Testing Center

If you are using the Tests that come with the program (built-in All The Right Type
Drillfile), the Testing Center contains a selection of tests to be used after every third
lesson.

Student Options that affect the Testing Center are:

-Test Mode
-Penalty

-Word Wrap
-Backspace Key
-Display lines
-Space after period

See the section 'Student Options and Their Implications' in this chapter for details.
Remember that 'Student Options' are set from within the Utility Center. See
chapter 5 'Setting Program options for your Students'. Words per minute and
errors are recorded for each test.

Changing the Default Word Processor

You can access your favorite word processor by clicking on the Word Processing
Plaza building. When you click on the Word Processing Plaza, All The Right Type
looks inside a folder called ATRT Pouch to find a file called WP Link. By default,
this file is an empty '"TeachText' stationery file. A 'stationery' file (sometimes called
a '"Template') is a file that always opens as a copy with the name 'Untitled' instead
of opening the original file.

If you prefer your students to use a different word processor, you need to replace
the WP Link file with one made by your own word processor. To create this file,
launch your word processor and make a new, empty document. Save it with the
name WP Link as a 'stationery' file (or a "Template') in the folder called ATRT
Pouch, replacing the default WP Link file.

ALLTHE RIGHT
E

Page 34

O~EIE



4. All The Right Type - Advanced Features

Student Options and Their Implications

This panel is accessible through the Utility Center. See chapter 5 'Setting Program
Options for your Students'.

Student Options

Student Name: [ N

[Drilifile... | iRl The Right Type ¢ [ clear Results

Lesson Error Threshold: Penalty: E =] Word Wrap

Lesson Error Effect: i) Beep {3 Caption Flash [<] Delete Key
[] Display Lines
Practice Mode: Standard Pacer Practice
' 9 [Juse 'WAM'
Test Mode: @ Speed Goal [ 15 WPM | | Space After Period:

(3 Timed Writing | 1 minute || Qone @Two

[ Help ] [ Cancel I I Change Il

Student Name

Drillfile

Clear Result

Lesson Error

Threshold

Lesson Error
Effect

Penalty

User (student) names can be up to 25 characters long.
Names must be unique within each Recordfile. While the
student is signed on, this name is displayed at all times.

Specifies which Drillfile the student will use when they run
All The Right Type. The default Drillfile is All The Right
Type. To change the Drillfile, click on the button on the
Student Options dialog, then select a new Drillfile. Existing
results are cleared if the Drillfile option is changed.

Removes all the results for the individual student

Specify the accuracy needed to automatically proceed to the
next line by pressing the RETURN key in the 'Learning Lab'
and 'Practice Pavilion' sections of All The Right Type.

Specify whether a sound or a title bar flash will occur when
a student makes an error in the Learning Lab.

Specify the WPM deducted for each error in a Skill Builder
or Test. WPM is calculated as follows:

WPM = (keystrokes/5) - (errors x penalty)

time in minutes

ALLTHE RIGHT'
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Practice Mode

Word Wrap

Backspace Key

Display lines

Use WAM

Space after

period

Specify whether a student will use the standard method or
the animated pacer practice in the 'Practice Pavilion'. This
depends on the age and motivation level of your students.

Standard mode, students are presented with text lines that
they type until a drill is completed. Since a speed goal is
selected by students, you can control the accuracy needed to
proceed automatically to the next line by setting the Penalty.

Pacer mode Unlike so-called games in other keyboarding
programs, the Pacer does not distract students with falling
letters, or random letters popping on screen. Yet it is highly
motivating and helps increase attention span.

Two racing sculls appear on screen. The upper one
represents the student, and the lower one a pacer scull set at
a preselected speed. Text appears just ahead of the student’s
scull and is 'eaten up' as the student types. The pacer scull
always moves at a steady pace, exactly equal to the WPM
goal. The objective, of course, is to beat the pacer scull to
the finish line.

If checked, automatically wraps text at the end of a line in
Skill Builders or Tests. Some teachers may prefer to simulate
old fashioned typewriters - where you had to pull back the
carriage between each line.

If checked, allows users to correct errors using the
Backspace key.

If unchecked, the drill material will not be displayed on the
screen during a Skill Builder or Test. If you uncheck this,
you must supply a printed copy of the drill material to each
student.

If checked, replaces the WPM abbreviation with WAM
(words a minute) in reports and on-screen messages.

Determines the number of spaces between sentences in the
built-in All The Right Type drill material.
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Test Mode In 'Speed Goal' mode users complete all the text in the Test
and are accurately marked. This is the preferred method.

In '"Timed Writing' mode you type for a specific period of
time. This system was designed for rooms full of typewriters
where the only way to mark fairly was to stop everyone at
the same time, collect papers and mark them. Some teachers
prefer this more traditional system.

For each mode you can specify a preset goal or time limit, or
you can give the user a choice by specifying 'User prompt'.

Backing Up and Security

The best security is a good back up! Recordfiles should be backed up regularly.
Files can be damaged by power failures, system crashes, improperly configured
'desktop security' programs, or by improperly exiting the program (turning the
power off without exiting the program properly).

The structure of All The Right Type has been designed so that there is limited
scope for students to create problems with the integrity of the records. Some
teachers have requested a password system, thinking that this would prevent
malicious students from harming the records. Password systems do have benefits -
but they can be very tedious to set up and students are constantly forgetting their
passwords and have to bother the teacher to reset the passwords. We evaluated all
concerns and tested our assumptions - and decided that we didn't need a password
system for the following reasons:

a) Teachers were concerned that students would get into the Utility Center and
'give themselves high scores'. However, the only way anyone can create scores
for themselves is by actually doing the work in All The Right Type.

b) Teachers were concerned that students might accidently sign on as the wrong
student. While this is possible, there is a huge "Welcome Susan' window that
appears after you have signed on. And the name appears in the titlebar and on
all reports and many windows throughout the program. It is difficult to
'accidentally’ sign on and not know it!

c) Teachers were concerned that mischievous students might deliberately sign on
as the wrong student to give that student poor scores. Again, the name is in
the titlebar and on all reports and many windows throughout the program. It
would be unusual for this cheating to pass unnoticed in a supervised lab.

LLTHE RIGH
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Also, All The Right Type only replaces scores if they have a higher WPM -
regardless of the number of errors (errors are already factored into the WPM
calculation). If they redo a score that the actual student has already done, and
get a worse score, it WOULDN'T replace the one in the Recordfile! The worst
they could do would be to create 0 WPM and large numbers of errors for Tests
and Skill Builders that had not yet been done. In this case, when the real
student did this material, the new score would instantly replace the lower one.

Teachers were concerned that students might deliberately get a skilled friend to
sign on as themselves in order to get better scores. Again, the name appears in
the titlebar and on all reports and many windows throughout the program. It
would be unusual for this cheating to pass unnoticed in a supervised lab.

No amount of password protection would guard against this - the student
would just give away his password, or quickly sign on to his friend's station.

The Utility Center allows deletion of names from Recordfiles. Therefore it may be
appropriate to keep it away from students.

On non-networked computers, the best way to deal with this problem is to prevent
access to the Utility Center using a desktop security program such as FoolProof
(from SmartStuff Software), At Ease (from Apple) or KidDesk (from EdMark). If
you do not have such a program and don't intend to get one, here are some ideas:

a)

Don't install the 'Utility Center' on the student's computers. Have them hand
in their recordfile to the teacher. The 'Utility Center' is only installed on the
Teacher's computer.

You could use the built-in Utility Center password system. This prevents
unauthorized use of the Utility Center to remove records and drills.

Unfortunately, these methods don't prevent a knowledgeable person from getting
to the recordfiles. Desktop security programs (such as those listed above) are the

only way to prevent this on non-networked computers. Make backups often.

On a network, the 'Utility Center' should be installed so that students cannot ever
'see' it. See chapter #1.
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How to Add and Remove Skill Builder Puzzles

At the end of a Skill Builder, part of a humorous cartoon is revealed. The cartoons
are randomly assigned when a student first signs on to All The Right Type. All
The Right Type comes with ten cartoons built right into the program file.

You can add your own pictures! To add a picture, copy it to the clipboard and run
the Utility Center. Choose 'Add Picture From Clipboard' from the Edit menu. The
picture on the Clipboard will be added to a database of pictures. When All The
Right Type chooses a picture at the end of a Skill Builder, it will choose one of the
ten built-in pictures, or it will pick from the pictures in the custom database.

To examine or remove pictures from the custom picture database, choose 'Delete
Picture From File..." from the Edit menu.

If your computers have the standard 640 x 480 screens, the pictures should be no
larger that 500 x 350 pixels, otherwise they will be scaled to fit in the window.
This may distort the picture - especially if it has lettering on it. Pictures must be
256 colors.

The contents of the custom picture database should only be changed at the
beginning of the year or semester. If you add pictures part way through your
classes, the picture that the students see the next time they log on may be different
than before. This may confuse or upset your students.
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9. KEEPING RECORDS OF STUDENT PROGRESS

Before you read this chapter, you should familiarize yourself with the Utility Center
by working through chapter 2.

Hﬁ ; The Utility Center allows you to manage your students' records.

Student records are contained in Recordfiles. Each Recordfile holds records for up
to fifty students. An individual record consists of lessons a student has completed

in the Learning Lab and Practice Pavilion plus their speed and accuracy during
Skill Builders and Tests.

Creating a new Recordfile

EEEEIEEE

Click the 'New Recordfile' icon at the left side of the toolbar. An empty new
recordfile will appear, with the name 'Untitled Recordfile' in the titlebar.

Adding Students

There are two ways to enter student names. You can either type them in (click the
'Add Student' icon in the toolbar) or import them from a text file.

Importing is faster if you already have an electronic file of your students' names in
standard TEXT file format. It must contain only names separated by carriage
returns. From an open Recordfile, choose 'Import Names..."' from the File menu. A
standard file location dialog appears. Locate the TEXT file and click Open. The
names are appended into the Recordfile.
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Setting Program Options for Your Students

The Utility Center allows you to control the way All The Right Type is presented
to students. You can set these for individual students or for the entire class.

Select a student name and click on the 'Edit Options' setting in the toolbar.

PR ER

The Student Options dialog appears. Set the options and click 'Change'. A screen
appears which allows you to apply these changes to all students in the Recordfile.

For a detailed explanation of each option and its implications for student
instruction see chapter 4. All The Right Type - Advanced Features.

Moving Students from one Recordfile to Another

On a single computer, or when records are kept centrally on a network, if students
change classes, it may be convenient to move them to another Recordfile. In the
Utility Center, open the Recordfile and select their name(s). Choose 'Move
Student...' from the Edit menu. A list of the other open recordfiles appears. Select
the destination recordfile and click the Select button.

If you have All The Right Type installed on different computers that are not
networked together, you have to use floppy disks to move recordfiles.

Converting Records (and Drills) from previous versions of All The Right Type

If you have been using the Black & White version of All The Right Type and you
have existing records or customized drills that you would like to use with the color
version (version 2), you must first open them in the Utility Center. It will detect
that they are from an older version of All The Right Type and offer to convert
them for you. Note that once they have been converted they can no longer be used
with earlier version of All The Right Type.
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Reports and Award Certificates
The Utility Center can generate the following reports:

Students - Learning Lab and Practice Pavilion drills completed
- Skill Builders and Test results, WPM and no. of errors
- Awards

Class - Results on particular Skill Builders and Tests
- Awards

If you want to see the records for a particular student, double-click the student's
name in the list or select the name and click the 'Eyes' icon in the toolbar. The
student record report opens displaying the student's WPM and number of errors
for Skill Builders and Tests. When the student record first opens it is in 'Text'
format. You can change this to graph format from the toolbar or View menu. If
you change to graph format the complete report requires four pages to display.
Use the left and right page icons to see the reports for other kinds of drills.

It's also possible to see how the entire class has performed on a particular Skill
Builder or Test. Click on the "Test Results' icon to see how everyone in the
Recordfile has done on a particular Test.

DD EEREE

Similarly, click on the 'Skill Builder Results' icon to see how everyone in the
Recordfile has done on a particular Skill Builder.

The Utility Center can also generate an award for individuals or groups of
students. Select the students to receive awards and choose 'Award' from the View
menu. The award is previewed on the screen. If you want to print, choose 'Print’
from the File menu or click the 'Print' icon in the toolbar.

How All The Right Type Saves Records

As long as a student signs on to All The Right Type by choosing a name in a
recordfile, records will automatically be saved into the recordfile as the drills are
finished. Students do not have to remember to SAVE. Records are not kept for
'Guests' or for 'Evaluators'.

Detailed results (WPM and Errors) are kept for the Skill Builder sections and for

LLTHE RIGH
A . (Y] @ T Page 43




5. Keeping Records of Student Progress

Tests. For the Lessons, only the status (finished or not finished) is recorded.

If you have to stop partway through a Lesson or Skill Builder, the program will
also record where you were. The next time you sign on, you will be prompted to
finish the exercise you were working on. This does not apply to Tests.

Managing Records in Non-Networked Labs

Install only the All The Right Type program on the students workstations, not the
Utility Center. Only the teacher should have the Utility Center program.

Use the Utility Center to create a recordfile containing the names of all the students
in the class. If you want your students to keep their records on floppy disks, put a
copy of the recordfile onto each student's disk. Otherwise, put a copy of the
recordfile on the hard drive at each station where All The Right Type is installed.
Read the section about the 'Floppy Merge' feature before proceeding.

You can have the students print out their own progress reports from the Records
Library periodically, or you could collect the recordfiles and use the 'Floppy
Merge' feature.

Floppy Merge

When Floppy Merge is selected, you will be prompted for the name of the
Recordfile that will become the end product of the Merge. You must use an
existing Recordfile to store the results. Once that master Recordfile has been
specified, the main dialog box will appear:

Flease insert a disk to merge from.

Merge It

[Eancel ] [ No More Disks ] [Su.litn::h Fluppies] [ Eject ]

After you have inserted the disk that contains the Recordfile you want to merge
into the master, click the "Merge It" button. The program will then search the
inserted disk for a mergeable file. If a recordfile is found, the merge process will
begin.
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If student names are encountered that are not in the Master recordfile, the program
will prompt you. If names match properly and the drillfile specifications are the
same, the records will be merged together, always keeping the best (highest) WPM
score and related errors score.

When the merge process is complete, you will be prompted to insert the next merge
disk. This process will continue until you click the "No More Disks" button or the
"Cancel" button.

The program will continue to search a disk until all Recordfiles have been
processed.
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6. MAKING YOUR OWN DRILLS AND TESTS

Creating Drill Files

ol Jid
EE

The Utility Center lets you create your own Dirillfiles for use with All The Right
Type. A Drillfile is a collection of Lessons, Skill Builders and/or Tests. Note that
the All The Right Type drillfile cannot be edited - but you can open it, make
changes and then do a 'Save As..' to create a new drillfile with a new name.

There is no limit, other than disk space, to the number of drillfiles you can create.

For All The Right Type to use drillfiles, they must be located in the same folder as
the All The Right Type application. However, the Utility Center can work with
drillfiles no matter where they are located.

To begin working with your own drill material, run the Utility Center.

B

Click on the 'New Drillfile' button in the Toolbar and an empty untitled drillfile
window appears.

S0=——— Untitled Drillfile | ==a0————]|
i Lesson i3 Skill Builder 1 Test
—Orills
1
-
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Once you have created some Skill Builders, Lessons or Tests (collectively called a
Drillfile), their names will appear in the list box when their radio button is clicked.
For example, clicking the Lessons radio button produces a list of all the Lessons in
the open Drillfile.

When you save your Dirillfile for the first time, you will be asked to name the
Drillfile. Names should be selected so that they will be relevant to the intended
users, such as Mr. Smith's Typing Exercises.

NOTE: You can change the name of the Drillfile at any time. The content of existing

Drillfiles should be changed with care once students have worked with them and
records have been kept. Correcting minor things such as spelling mistakes are no
problem, but wholesale changes will render the existing records meaningless.

Adding Your Own Drill Material

1.

Choose the type of drill material you want to create by clicking the
appropriate button. Lessons are used in the 'Learning Lab' and 'Practice
Pavilion', Skill Builders in the 'Skill Building' and Tests in the 'Testing Center'.

Click on the + icon in the toolbar to create a new entry. For example, to create
a new Skill Builder, click the Skill Builder radio button and click the + icon in
the toolbar.

You can begin typing in your drill material. If you already have the drill
material saved in a word processor file, just open it, copy the text and paste it
into the above window.

For example, if you have drill material in Microsoft Word format, open the file
in Word and copy the text you want to use. Then switch to the 'Utility Center'
and open or create the drill. Position the cursor where you want the paste to
begin, and choose 'Paste' from the Edit menu. The copied text is pasted into
the drill.
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Creating Lessons

Lesson files can contain a maximum of twenty lines, each with a maximum length
of forty characters.

Blank lines in the middle of a Lesson are not allowed, although blank lines at the
end are quite acceptable.

Creating Skill Builders

Skill Builders have three sections respectively called 'Isolated Words', 'Sentences'
and 'Paragraph'. When first entering a Skill Builder edit window, the radio button
next to 'Isolated Words' will be selected. To indicate that you want to edit one of
the other two sections, just click the appropriate radio button.

=[[I== Untitled Drillfile: Skill Builder - My First Skill Builder

Skill Builder Number 1

Skill Builder Section: @ Isolated Words 1 Sentences
{_» Paragraph

Isolated Words MaH Lines 6
Line 1 || iH
Line
Line
Line
Line
Line

[ U ) Y R TGN

=

Each Skill Builder section can contain a maximum of six lines, each with a
maximum length of forty characters.

Blank lines in the middle of a section are allowed. When they are used by students
in All The Right Type, they are indicated by the paragraph symbol ']".

Creating Tests

Each Test can contain a maximum of fifty lines, each with a maximum length of
forty characters.

Blank lines in the middle of a Test are allowed. When they are used by students in
All The Right Type, they are indicated by the paragraph symbol '{'.
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Using Your Drillfile with All The Right Type

For All The Right Type to use custom Drillfiles, they must be located in the same
folder as the All The Right Type application. Students can choose any Drillfile
when they sign on as 'Guest'.

You can ensure that your custom Drillfile is used automatically by setting the
Drillfile option on the Student Options dialog (see chapter 5 'Setting Program
Options for Students'). The student's work using custom Drillfiles is marked and
recorded in the same way as All The Right Type's built-in Drillfile.

NOTE: If you have existing Recordfiles for classes that use the All The Right Type Drillfile
and you want to make them use a Drillfile of your own without clearing the existing
results, make a copy of the Recordfile, rename it and then open it and change the
drillfile specification. For example, if you had a recordfile called 'Period 1A’
containing 30 students' records using the All The Right Type Drillfile, make a copy
and rename it 'Period 1A - Custom'. Then open it it the Utility Center, pick any
student and change the Drillfile option to your own custom Drillfile. When you click
'Change' it will allow you to apply this change to all students in the recordfile at once!

Editing Drillfiles
Editing Drills

Once you are inside a Drillfile, you can edit the Lessons, Skill Builders and Tests of
a Drillfile by double-clicking on their name. Use the radio buttons to see the
names of the different material in the Drillfile. When a Drill is open, the common
Macintosh editing features are available.

Ordering Drills

The order of drill material that students see within the All The Right Type program
is the same as the order you see in the Drillfile window. The order of those titles
can be changed to suit your tastes. To move a Drill, select it, then click on the 'Up'
or 'Down' button. The Drill will move one position.

Deleting drill material

To delete an existing Lesson, Skill Builder, or Test, select it and click the '-' button
in the Toolbar.
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Renaming drill material

A Lesson, Skill Builder or Test can be renamed by selecting it and then choosing
'Rename Drill..." from the Edit menu.

Duplicating drill material

You can duplicate a drill by opening it, selecting the text you want to copy and
pressing Ctrl <C>. This will copy it into the clipboard. Create a new drill and
press Ctrl <V>. The text in the clipboard is pasted into the drill.

Viewing and Printing

The material in a particular drill can be displayed by double-clicking on the drill
name. Then it can be printed by choosing 'Print' from the File menu.

If the 'Display lines' option is disabled, the drill material will not be displayed on
the screen during a Skill Builder or Test. If you uncheck this, you must supply a
printed copy of the drill material to each student. If you are using the All The
Right Type Drillfile, make sure you set the 'Space after period' option to be 'one'.

Converting Drills (and Records) from previous versions of All The Right Type

If you have been using the Black & White version of All The Right Type and you
have existing records or customized drills that you would like to use with the color
version (version 2), you must first open them in the Utility Center. It will detect
that they are from an older version of All The Right Type and offer to convert
them for you. Note that once they have been converted they can no longer be used
with earlier version of All The Right Type.
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7. TEACHING KEYBOARDING IN YOUR CLASSROOM

Group vs. Individual instruction

Some teachers prefer a highly structured class situation in which students progress
from lesson to lesson as a group. Other teachers prefer their students to proceed
according to their ability. Both group and individualized learning work well. In
any case, students must follow the proper learning sequence (chapter 3) whether
they are being taught as a group or are working independently.

Time allotment

Whether you choose group or individualized instruction, like any skill, learning
keyboarding takes time. Research shows that daily lessons of approximately 35
minutes each spread over approximately eight weeks is ideal. Based on a minimum
of 35 minutes per session, it takes approximately 25 hours to cover the 13
alphabetic Lessons, Skill Builders, and Tests in accordance with the proper learning
sequence (chapter 3).

College and Adult Education level classes

Teaching keyboarding at the college and adult education level sometimes poses a
problem not usually found at the secondary level. This is the practice of daily,
weekly, or monthly intake of new students.

The solution is to use All The Right Type in an individualized learning
environment. Because All The Right Type marks accurately according to the rules
approved by leading typing authorities and stores student results, you are freed of
the problem of trying to keep up with marking. Thus you have more time to give
individualized help to students who need it. In addition, because the program has
the ability to give instant feedback on speed and accuracy, as well as reteach finger
reaches whenever errors occur, it puts at your disposal a tireless teacher aide.
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8. APPENDICES

a) Posture Diagram
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b) Error marking rules

The analysis and marking of errors in All The Right Type follows standard

marking rules for typing. At the end of each line, the student's work is analyzed
and any errors are highlighted. Missing spaces and missing words are highlighted
in the top (source) line. Incorrect words and extra spaces are highlighted on the
bottom (typed) line. Remember, it is not necessary to line up exactly with the
letters above. The rules for marking are:

1.

If there are wrong, missing or extra letters in a word or the punctuation
following it, they each count as a single error.

For eqample: A purple cow ate green grass.

A cow ate grass.

This line has only two errors, even though three keystrokes were incorrect.
Notice that the word 'grass' was marked correct, even though it did not line up
exactly with the word above it.

If the spacing between words (or at the left edge) is incorrect, it counts as a
single error, no matter how many keystrokes are missed or added. The only
exception is when students make a spacing error in an attempt to line up
exactly with the corresponding characters in the above line. The program does
not count this as an error.

For edample: Alpurple cow ate green grass.
Apurple cow ate green grass.

This line has only one error, a missing space between 'A' and 'purple'. Notice
that the spacing between 'cow' and 'ate' was marked correct, because it was an
attempt to line up vertically.

If a word is left out, it is considered to be one error.

For esample: A purple cow EXE green grass.
A purple cow green grass.

If extra or duplicate words are typed, even at the end of the line, each is
considered to be one error.

For example: A purple cow ate green grass.
A purple cow ate [iff green grass.
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c¢) Troubleshooting

Here is a list of checkpoints to consider if you run into problems.

If you are running over a network, make sure that you have followed the
directions for your particular network.

If you are running over a network, make sure that the problem is really related
to the network and not the local system or software.

Make sure that the problem is not related to a local 'desktop security' program
such as At Ease, Kid Desk, FoolProof or On Guard. If you turn off the local
'desktop security' program and All The Right Type works fine, consult the
manual for your 'security' program or call their technical support department.

All The Right Type uses only standard files that are supported on any
Macintosh compatible network. While Ingenuity Works Inc. offers toll-free
technical support for our products and provides information on how they are
to be set up on networks, we can't provide free support for standard network
procedures such as deleting files or sharing folders or sharing files or setting
access rights. For questions of this nature, you may be able to find an answer
in your network manual. Or consult your district computer coordinator. Or
call the company that makes the networking software.

PROBLEM: While installing 1 get "... disk related error (-36) bas occurred."

Your disk drive may be out of alignment. Try installing on a different
computer or a different floppy drive if you have one. If it works on one drive
but not on the other, then you know that your floppy drive needs servicing.

The installer disk may be damaged or defective. You should first try to repair
the disk. All Macintosh System software comes with a disk repair utility called
'Disk First Aid'. System 7 owners can find it on the disk labelled 'Disk Tools'.
Another common utility is 'Norton'.

If you can't find your copy of 'Disk First Aid', or the utility was unable to
repair the disk, use your backup copy of the installer disks or see warranty
information at the end of this section.

PROBLEM: I get an error message that says "There is not enough memory to
open All The Right Type".

You may already be running other programs that are using up too much
memory. Quit these programs.
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Someone may have set the systems 'Disk Cache' to be very large. Go to the
control panel called "Memory" and decrease the size of the 'Disk Cache'.
Close the control panel and restart your computer.

The minimum Application memory size should not be set less than 2500K. If
your system does not have this much spare RAM, you will have to get more
RAM (hardware) to run All The Right Type. To change the minimum
Application memory size, select the program icon then select 'Get info' from
the File menu. Change your memory requirement to as much as you can
afford to spare. The more memory you give it, the faster it will run. Do NOT
turn on 'Virtual Memory'. 'Virtual Memory' uses the hard drive for storage
and is much slower the real RAM. It will slow down your Macintosh.

PROBLEM: I have 'At Ease' and I can't figure out records.

See page 4 of this manual.

PROBLEM: I'm trying to install the program and my screen says "This disk is
unreadable: Do you want to initialize it?"

Your disk drive may be out of alignment. If this disk works in other disk
drives, it is likely that your drive needs servicing.

The installer disk may be damaged or defective. You should first try to repair
the disk. All Macintosh System software comes with a disk repair utility called
'Disk First Aid'. System 7 owners can find it on the disk labelled 'Disk Tools'.
Another common utility is 'Norton'.

If you can't find your copy of 'Disk First Aid', or the utility was unable to
repair the disk, use your backup copy of the installer disks or see warranty
information at the end of this section.

PROBLEM: No sound

If anything is plugged into the external headphone jack on the back of the
Macintosh, the internal speaker is automatically disconnected.

The system 'Sound' control panel may be set to zero volume.

It is possible that another application is running in the background and it has

taken the sound channel. Try quitting the other application and re-launching
All The Right Type.
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If All The Right Type is taking all the available memory, the system may not
have enough to initialize the sound hardware. Make sure that the "preferred"
memory is no larger than 30K less than the largest block available.

PROBLEM: The program is not saving my records!

Detailed records (WPM and errors) are only kept for Skill Builder sections and
Tests. For Lessons, only the status (finished or not finished) is recorded.

Did you use the Utility Center to set up a Recordfile? Did the student sign on
through his name in the Recordfile? If he did, it will appear in the titlebar of
all Lesson, Skill Builder or Test windows. If they are signed on as a guest,
records will not be kept from one session to another.

If you are looking at 'graphic' format reports, try using the 'Next Page' and
'Previous Page' buttons.

If you have a Site License and the Recordfile is on a network, see the separate
document called Site License/Network Supplement.

PROBLEM: The animation is sluggish.

Perhaps the processor in your computer doesn't meet the minimum
requirements of All The Right Type. See the system requirements in chapter 1.

Check the 'Virtual Memory' setting on the '"Memory' Control Panel. 'Virtual
Memory' uses the hard drive for storage and is much slower the real RAM. It
will slow down your Macintosh. Remember to restart your system after
making changes to your memory settings.

Perhaps there is another program running in the background. Quit any other
programs (except Finder).

If your computer is connected to a network, it is possible that someone has
logged onto your computer and is transfering data to/from your hard drive.
You will have to wait until the transfer is finished.

PROBLEM: The printer isn't printing.

Is the printer plugged in, turned on and on line? If it isn't pressing the "On
Line" button or equivalent should solve the problem.

Is the printer cable properly connected to the printer and computer?

Perhaps the printer has been initialized badly by the computer. Turn the printer
off to erase its memory, then turn it back on.
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e If there is consistently erratic printing from All The Right Type and other
programs, your printer driver (in your system folder) may not be compatible
with your printer. In that case it should be updated.

PROBLEM: I can't remember my password to the Utility Center. Or I need to
change the password to the Utility Center.

e The encoded password is stored in a file called 'ATRTGP' inside the ATRT
Pouch folder, which is located in the same folder as the All The Right Type
program. Drag the 'ATRTGP" file into the trash and empty the trash. The
next time you run the Utility Center you will be able to reset the password.

PROBLEM: I was working my way through the Skill Builders and now when 1
finish a Skill Builder, I get a different cartoon than I used to!

e Someone has changed the contents of the custom picture database. See chapter
4 'How to Add and Remove Skill Builder Puzzles'.

PROBLEM: On some computers the hands and fingers are transparent and on
others they are solid.

e If your computer's processor is near the minimum required for the program, it
may not be powerful enough to do the transparent hands without causing
sluggish response. Rather than cause sluggish response, we decided to just use
solid hands which draw much faster. In general, systems with a 68040 or
PowerPC processor are powerful enough to display transparent hands.

e If the All The Right Type program is only getting the minimum memory
requirement (2500K), there will not be enough memory to use transparent
hands, so the program uses solid hands. Setting the minimum to the suggested
size will ensure transparent hands (providing the processor is powerful
enough). To change the minimum Application memory size, select the
program icon then select 'Get info' from the File menu. Do NOT turn on
'"Virtual Memory'. 'Virtual Memory' uses the hard drive for storage and is
much slower than real RAM. It will slow down your Macintosh.

PROBLEM: I have changed to a new Word Processor and now I want to link the
Word Processing Plaza to it instead of my old one.

e See page 32 of this manual.
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PROBLEM: When I click on the Word Processing Plaza I get the message 'There is
not enough memory...'.

e  When you click on the Word Processing Plaza the computer's operating system
tries to launch a word processor (see page 32). If the computer doesn't have
the amount of free memory required by the word processor (it varies from one
word processor to another) it won't be able to launch. You could set up a link
to a simple word processor such as 'SimpleText' or '"TeachText' which doesn't
require as much memory as a full fledged word processor. Also, try the
memory suggestions on page 57.

Problem: When I click on the Word Processing Plaza the word processor never
appears, and the application menu icon in the upper right corner of the menubar
starts flashing.

e There is a problem launching your word processor. Choose 'Finder' from the
application menu to see the details of the problem.

PROBLEM: Everything is too small on my screen.

e Perhaps your display is set to a high resolution such as 1024x768 or larger.
Try setting your display to a lower resolution such as 640x480 (256 colors).

Problem: On the Student options dialog the 'Space After Period' option is greyed
(disabled).

e This option is only available for the built-in drillfile called 'All The Right
Type'. If you have specified a custom drillfile or are using a converted drillfile
from a previous version of All The Right Type, this option is not available.

d) Technical Support

The solutions to most problems are listed in the preceding "Troubleshooting'
section. If you have internet access you can also check our technical support web
pages at <www.ingenuityworks.com>.

From 9:00 am to 5:00 pm Pacific time, Ingenuity Works offers technical support
for our customers. Please tell us that you are part of the Ontario Provincial license,
and have the following information before calling for help.
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- All The Right Type version number

- Macintosh System and Network Software version numbers

- Exactly which program were you running when the problem occurred (Installer?
Utility Center? All The Right Type?)

- Names and versions of any 'security' programs (KidDesk? FoolProof?)

- Exactly what you were doing when the problem occurred

- Exact wording of any error messages

email: support@ingenuityworks.com (please include name and phone number)
FAX: (604)431-7996
Phone: (604) 412-1555 extension #312

Office hours are 9am to Spm Pacific time.

e) Student Take-Home disks

As part of your provincial license, all schools operating under the Ministry of
Education and Training for the Province of Ontario have the right to use the
program inside the school - but they do not have the right to let the students take
home copies of the program (see Notification of Provincial License Agreement at
the start of this manual).

However, as part of the Licensing Agreement, any student attending a school
operated by the Ministry of Education and Training of Ontario can purchase a
copy of the program for use on their home computer! These 'Take-Home' disks
come with an instruction manual, toll free technical support, full guarantee and are
available in the following formats:

Windows 3.1 (Win 95 compatible) CD-ROM

Windows 3.1 (Win 95 compatible) 3.5" disks

Macintosh Colour CD-ROM

Macintosh Colour 3.5" disks

MS-DOS 256K RAM  3.5"

MS-DOS 256K RAM  §5.25"

Macintosh Black and White (Plus or more recent model) 3.5"
Apple Ile, Ilc, Ilc+ (IIGS compatible) 64K RAM 5.25"
Apple Ile, Ilc, Ic+ (IIGS compatible) 64K RAM 3.5"
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To make it easy for the teachers to offer this "Take-Home' program to the students,

we have two possible ordering systems:

#1 - Minimum teacher involvement:

Ask your students to raise their hands if they have a computer at home and
count them.

Call Ingenuity Works toll free at 1-800-665-0667 and request the required
number of special 'postage-paid' information/ordering forms.

Pass the forms out to your students. The students take home the forms and
the parents can order directly from Ingenuity Works. Ingenuity Works will
ship directly to the students home. All technical support or damaged disk
replacements are handled directly by Ingenuity Works - not the school.

#2 - School fund raiser:

Decide how much profit you want to make on each disk, add your cost + the
GST (see form) and write the amount on the 'Price per disk' line of the Student
Order Form (next page of this manual). Typically a school may offer these
disks at $20.00 - still a very affordable price for a typing program of this
quality.

Make copies of this form and distribute them to students.

Collect the forms and payment from interested students and consolidate the
orders onto the Teacher Order Form. Mail the Teacher Order Form with

payment to Ingenuity Works. We will also accept FAXed orders accompanied
by a school P.O. number.

When the disks arrive, distribute them to your students. That's all there is to
it! All technical support or damaged disk replacements are handled directly by
Ingenuity Works - not the school.
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Student
Order Form

All The Right Type
Take-Home disk

Keyboarding

is an essential skill in today’s
computer oriented world. Most
people need to type

20 - 30 words per minute in
order to effectively use
computer applications such as
word processors and data
bases.

All The Right Type is used by
students throughout North
America to help develop this
vital skill. Now your whole
family can use the same
program to get valuable extra
practice - at a very economical
price!

The Take Home Disk has all the
features of All The Right Type
used at school, and is available

a manual and technical support!
To get your copy of All The
Right Type, fill out this form
indicating computer type & disk
size, return it with payment to
your teacher. Disks will be
distributed to students at the
school.

Make cheques payable to:

System Requirements

Windows requires Windows 3.1,
Windows 95,386/33 Mhz, 8 Mb RAM,
9 Mb hard Drive, SVGA graphics

Macintosh (Colour) requires 68030/25
Mhz or better, 640 x 480 colour
graphics, System 7 or higher

DOS(Text B&W) requires 256K RAM.
Macintosh(B&W) requires Mac Plus or
later.

Yes! Please send me an All The
Right Type Student Take Home
disk.

Computer Type: Price
O Win/Mac CD

O  Windows Disk

O  Mac Disk

Black & White Versions

0 DOS 3.5" Disk

O DOS 5.25" Disk

O Mac B
O Apple 3.5" Disk

O Apple 5.25" Disk

Name

Class

Amount

Enclosed$

Price includes taxes (if applicable), shipping and

for most popular computers. It appe requires Apple lle, Ilic, lic+ or nanding.
is fully guaranteed and includes  (llas compatible).
Complete this form and return it to your teacher by !

(Date Required)




A

Teacher
Order Form

Instructions:

1. Duplicate the Student Order
Form (after filling in the
prices) and distribute it to
your students.

2. Use those forms when they
come back to fill out this form.

3. Mail with payment or P.0. to:

Ingenuity Works Inc.

3738 North Fraser Way
Suite 101, Burnaby,BC V5J 5K8

or FAX with P.0. to

FAX: (604) 431-7996

NOTE: Only schools operating

under the Ministry of Education
and Training of Ontario are

eligible for this offer.

Thank you!

Qty. Computer [S):glg Price Total
Windows/Mac Hybrid CD-ROM $15.00
Windows on Disks 3.5" disk $15.00
Macintosh on Disks 3.5" disk $15.00
MS-DOS/IBM (B&W) 3.5" disk $10.00
MS-DOS/IBM (B&W) 5.25" disk $10.00
Apple (lle, llc, llc+, 1IGS) 3.5" disk $10.00
Apple (lle, lic, llc+ 11GS) 5.25" disk $10.00
Macintosh (B&W) 3.5" disk $10.00
Fedex Shipping | $10.00
Questions? Sub-Tota
Call toll free 7% GST
1-800-665-0667 TOTAL

O School P.O.#

Name of ordering teacher

O Cheque

Exact name of school

O VISA

Make all cheques and
money orders payable to
“Ingenuity Works Inc.”

O Money Order
0 MasterCard

Name on card

School Address

Card Number

Expiry Date

City

Postal Code

Province

Signature
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f) About Ingenuity Works Inc.

Ingenuity Works began developing educational software in 1983 and since then has
become Canada's leading developer of innovative products for education.

We've produced the 'Fay' and 'Crosscountry' series, All The Right Type and The
Brenda Summers Writing Files. The company's products have won many awards -
six products have been selected for inclusion in the 'Only the Best' guide.

New products and continuing enhancement of older ones are critical for the long
term success of the company. Our new product development is focused on
educational simulations and products to develop the writing process.

For information (other than technical support), Ingenuity Works can be reached at:

Phone: (604) 412-1555 email: info@ingenuityworks.com
FAX: (604) 431-7996

g) Credits
The development team:

Ernest Beaucamp - Ernie is a retired business education teacher who has
taught keyboarding at both the college and high school levels. He has
been a feature speaker at workshops across the country.

Jeffray Sinclaire - Jeffray is responsible for the creation of the graphics. Bruce
Law Photography digitally photographed the real life on-screen
images. Andrew Wareing was our rowing model.

Gerald Parnis - Gerald is responsible for the programming.
Dave Vincent - Dave is responsible for project management.

Quality Assurance:
The QA team included Elizabeth Knight, Dave Vincent and Paul Melhus.

Operations:

The operations team included Jay Fox and Martin Edwards.

Cartoons:

The cartoons you see at the end of a Skill Builder were drawn by John
McPherson. They are part of his 'Close To Home' series.
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9. Index

Index

Symbols
' characters 49

A

Abbreviation (WPM or WAM) 36
Adding
Drillfiles 48
students 18, 41
All The Right Type 15
Assigning Drillfiles 50
At Ease 13
Award Certificates 43

Backing up
Installer Disks 2
Recordfiles 37
Backspace Key option 36

C

Cartoons 66
Class records

viewing and printing 26, 43
Clear Result option 35
Completed Lessons, viewing 27
Converting recordfiles

previous versions 42
Copying

Drillfiles 50

drills 51
Creating

Lessons 49

Skill Builders 49

Tests 49
Credits 66
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D

Deleting
drills 50
Display lines option 36
Drillfile option 35
Drillfiles
assigning to a student 35
overview 17, 47
using 47, 50
Drills
copying 51
deleting 50
duplicating 51
editing 50
importing text into 48
ordering within a Drillfile 50
printing 51
Duplicating
drills 51

E

Editing

Drills 50
Error Messages. See Troubleshooting
Errors

Effect option, Lessons 35

marking 56

Penalty option 35

Threshold option, Lessons 35
Evaluator 25
Evaluator Guest 32

F
Floppy Merge 44
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G

Graphics requirements 39
Guest 32
Guided Tour 17

H

Hand position tutorial 32
Help. See Troubleshooting

Importing

student names 41
Installation

stand-alone computers 2

K

Keeping records 41
Keyboarding
group vs. individual 53
hand position tutorial 32
posture diagram 32, 55
teaching 53
time allotment 53
with adults 53

L

Launching

Utility Center 13
Learning Lab 20

15, 29, 32

Learning sequence 29
Lesson Error Effect option 35
Lesson Error Threshold option 35
Lessons

creating 49

renaming 51

selecting 21

viewing completed 27
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Marking
error marking rules 56
Memory 57, 58
Merging Records 44
Messages. See Troubleshooting
Motivating students
award certificates 26, 43
cartoon puzzles 23
fireworks 21
trophy 33
Moving
students 42

0

Options 35
Ordering Drills within a Drillfile 50

P

Pacer practice 22, 36
Password

changing 60

forgetting 60

Utility Center 38
Passwords

student 37
Penalty option 35
Posture Diagram 32, 55
Practice Mode Option 36
Practice Pavilion 15

overview 21, 29, 33
Printing

Drills 51

records 25

student records 43

troubleshooting 59
Problems. See Troubleshooting.
Puzzles

adding and removing 39

troubleshooting 60
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Q
Quick Tour 15

R

RAM, requirements 2
Record Keeping 41
Recordfiles
adding students 41
backing up 37
creating 17, 41
moving students 42
overview 16, 41
security 38
Records
and floppy disks 44
keeping 43
saving 43, 59
viewing 25
Records Library 15, 25
Replacing scores 38
Reports
viewing and printing 26

S

Security 37
Sequence 29
Setting Program Options 42
Signing on

as a guest 32

through a Recordfile 19
Skill Builders

creating 49

renaming 51

sections 23
Skill Building 15

overview 23, 29, 33
Sound 58
Space after period option 36
Speed, Calculating WPM 35
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Student Name option 35
Student Names, importing 18
Student Options 35

Backspace Key 36

Clear Result 35

Display Lines 36

Drillfile 35

Lesson Error Effect 35

Lesson Error Threshold 35

Penalty 35

Practice Mode 36

Space after period 36

Student Name 35

Test Mode 37

WAM 36

Word Wrap 36
Student records

viewing and printing 26, 43
System requirements 2

T

Teaching Keyboarding 53
Technical Support 61
Test Mode option 37
Testing Center 15, 24

overview 30, 34
Tests

creating 49

renaming 91

selecting 24

Speed Goal mode 37

Timed Writing mode 37
Timed Writings 37
Troubleshooting.

display size 61

hands 60

installation 57, 58

memory 37

missing DLL 61
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password 60

printing 99

puzzles 60

saving records 59

slow, jerky animation 60
sluggish animation 59
sound 58

Word Processing Plaza 60

U

Utility Center 15
Drillfiles 47
overview 16, 41

V
Viewing Records 26, 43
W

WAM option 36
Word Processing Plaza 15, 25
Word Processor

Changing the default 34
Word Wrap option 36
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